
 

 

 

 

 

 

Engine with Propeller Tutorial 

(Professional) 

 

  



Copyright © 2020 FunctionBay, Inc. All rights reserved. 

User and training documentation from FunctionBay, Inc. is subjected to the copyright laws 

of the Republic of Korea and other countries and is provided under a license agreement 

that restricts copying, disclosure, and use of such documentation. FunctionBay, Inc. hereby 

grants to the licensed user the right to make copies in printed form of this documentation if 

provided on software media, but only for internal/personal use and in accordance with the 

license agreement under which the applicable software is licensed. Any copy made shall 

include the FunctionBay, Inc. copyright notice and any other proprietary notice provided by 

FunctionBay, Inc. This documentation may not be disclosed, transferred, modified, or 

reduced to any form, including electronic media, or transmitted or made publicly available 

by any means without the prior written consent of FunctionBay, Inc. and no authorization is 

granted to make copies for such purpose. 

Information described herein is furnished for general information only, is subjected to 

change without notice, and should not be construed as a warranty or commitment by 

FunctionBay, Inc. FunctionBay, Inc. assumes no responsibility or liability for any errors or 

inaccuracies that may appear in this document. 

The software described in this document is provided under written license agreement, 

contains valuable trade secrets and proprietary information, and is protected by the 

copyright laws of the Republic of Korea and other countries. UNAUTHORIZED USE OF 

SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL 

PROSECUTION. 

 

Registered Trademarks of FunctionBay, Inc. or Subsidiary 

RecurDyn is a registered trademark of FunctionBay, Inc. 

RecurDyn/Professional, RecurDyn/ProcessNet, RecurDyn/Acoustics, RecurDyn/AutoDesign, 

RecurDyn/Bearing, RecurDyn/Belt, RecurDyn/Chain, RecurDyn/CoLink, RecurDyn/Control, 

RecurDyn/Crank, RecurDyn/Durability, RecurDyn/EHD, RecurDyn/Engine, 

RecurDyn/eTemplate, RecurDyn/FFlex, RecurDyn/Gear, RecurDyn/DriveTrain, 

RecurDyn/HAT, RecurDyn/Linear, RecurDyn/Mesher, RecurDyn/MTT2D, RecurDyn/MTT3D, 

RecurDyn/Particleworks I/F, RecurDyn/Piston, RecurDyn/R2R2D, RecurDyn/RFlex, 

RecurDyn/RFlexGen, RecurDyn/SPI, RecurDyn/Spring, RecurDyn/TimingChain, 

RecurDyn/Tire, RecurDyn/Track_HM, RecurDyn/Track_LM, RecurDyn/TSG, RecurDyn/Valve 

are trademarks of FunctionBay, Inc. 

 

Edition Note  

This document describes the release information of RecurDyn V9R4. 

  



Table of Contents 

Getting Started ....................................................................... 5 

Objective ............................................................................................... 5 

Audience ................................................................................................ 6 

Prerequisites ........................................................................................... 6 

Procedures ............................................................................................. 6 

Estimated Time to Complete ..................................................................... 6 

Creating the Initial Model ......................................................... 7 

Task Objective ........................................................................................ 7 

Estimated Time to Complete ..................................................................... 7 

Starting RecurDyn ................................................................................... 8 

Importing the CAD Geometry .................................................................... 9 

Adjusting the Icon and Marker Size ......................................................... 13 

Saving the Model .................................................................................. 13 

Organizing the Geometry ......................................................... 14 

Task Objective ...................................................................................... 14 

Estimated Time to Complete ................................................................... 14 

Merging the Imported Geometry ............................................................. 15 

Renaming the Bodies ............................................................................. 18 

Creating a Second Propeller Blade ........................................................... 19 

Rotating the New Blade .......................................................................... 20 

Saving the Model .................................................................................. 21 

Creating Joints ....................................................................... 22 

Task Objective ...................................................................................... 22 

Estimated Time to Complete ................................................................... 22 

Attaching the Blades to the Hub with Revolute Joints ................................. 23 

Attaching the Propeller Hub to the Engine ................................................ 24 

Attaching the Engine to Ground with a Fixed Joint ..................................... 25 

Defining the Rotation of the Propeller ...................................................... 25 

Saving the Model .................................................................................. 27 

Creating Forces ...................................................................... 28 

Task Objective ...................................................................................... 28 

Estimated Time to Complete ................................................................... 28 

Controlling the Translation of the Propeller ............................................... 29 

Controlling the Local Rotation of the Propeller Blades ................................. 29 

Saving the Model .................................................................................. 30 

Performing Analysis ................................................................ 31 

Task Objective ...................................................................................... 31 

Estimated Time to Complete ................................................................... 31 

Performing Dynamic/Kinematic Analysis ................................................... 32 



Creating Scopes and Setting Force Display ................................ 33 

Task Objective ...................................................................................... 33 

Estimated Time to Complete ................................................................... 33 

Creating Scopes of Revolute Joint Rotation ............................................... 34 

Setting Display of Forces ........................................................................ 36 

Saving the Model .................................................................................. 33 

Performing a Design Study ...................................................... 34 

Task Objective ...................................................................................... 34 

Estimated Time to Complete ................................................................... 34 

Adjusting the Stiffness and Damping of Rotational Springs ......................... 35 

Running a New Analysis ......................................................................... 36 

Questions to Consider from the Design Study Results: ............................... 38 

Ideas for Further Exploration: ................................................................. 38 

Plotting the Results ................................................................. 39 

Task Objective ...................................................................................... 39 

Estimated Time to Complete ................................................................... 39 

Creating a Plot ...................................................................................... 40 

 

 



E N G I N E  W I T H  P O R P E L L E R  T U T O R I A L  ( P R O F E S S I O N A L )  

 

5 

Getting Started 

Objective  

In this tutorial, you will learn how to: 

▪ Import geometry that was created by using a CAD system 

▪ Organize the imported geometry into the bodies needed for the simulation 

▪ Define translational and rotational spring forces 

▪ Define scopes that display a model output within a floating window in the modeling 

environment 

You will also practice skills that you learned in the previous tutorial, 3D Slider Crank: 

▪ Constraint modeling to connect the left and right blades with the propeller hub and to 

connect the propeller hub to the engine 

▪ Running a simulation, animating the model, and plotting 

the results 

In all, you will:  

▪ Create a simple model of an aircraft engine with an 

attached propeller 

▪ Study the relationship between the motion of a point at 

the tip of the propeller and the motion of the drive shaft 

▪ Express model outputs in the form of plots and 

animations 

  

  

Chapter 

1 
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Audience  

This tutorial is intended for new users of RecurDyn. All new tasks are explained carefully. 

Prerequisites 

Users should firstly work through the 3D Slider Crank Tutorial or the equivalent. We 

assume that you have a basic knowledge of physics. 

Procedures 

The tutorial is comprised of the following procedures. The estimated time to complete each 

procedure is shown in the table 

Procedures Time 

(minutes) 

Simulation environment set up and geometry 

import 

15 

Organizing the geometry 20 

Joint/motion creation 15 

Force creation 10 

Analysis 5 

Scope and force display creation 10 

Design study 15 

Plotting/Animation 10 

Total  100 

 

Estimated Time to Complete 

100 minutes  
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Creating the Initial Model 

Task Objective 

You will begin this tutorial by learning how to set up the simulation 

environment, including setting units, materials, gravity, and the 

working plane. In addition, you will learn how to import the CAD 

geometry that models the propeller blade, propeller hub, and engine 

housing.  

 

 

 

 

Estimated Time to Complete 

15 minutes 

  

  

Chapter 

2 
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Starting RecurDyn 

To start RecurDyn and create a new model: 

1. On your Desktop, double-click the RecurDyn icon.  

RecurDyn starts up and the Start RecurDyn dialog box appears. 

 

2. In the model Name text box, enter the name of the new model as Engine_Propeller.  

3. Set Gravity to –Z and leave the defaults for all the other options.  

4. Click OK. 

 

Tip: Allowed Characters for Entities  

You cannot use spaces or special characters in the model name or in any RecurDyn entity. You 

can use the underscore character to add spacing to improve the readability of the name. 
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Importing the CAD Geometry  

Now you will import the CAD geometry for the propeller blade, propeller hub, and engine 

housing. This is a typical way you would use RecurDyn. Create the modeling geometry in a 

CAD program and import the CAD geometry into RecurDyn for analysis. 

To import the propeller blade geometry:   

1. From the File menu, click Import. 

2. In the Import window that appears, set Files of type to 

ParaSolid File (*.x_t,*.x_b …). 

3. In the EngineWithPropeller folder of the RecurDyn 

installation, select the file: Prop_Blade.X_T. Please note that 

the default location of this folder is <Install Dir> \Help 

\Tutorial \Professional \EngineWithPropeller 

4. Click Open. The CAD Import Options window appears. Clear 

the Assembly Hierarchy checkbox and click the Import 

button. 

Notice that the blade geometry appears in the Working window and the body names 

ImportedBody1 and ImportedBody2 appear in the Database window.  

5. Select both ImportedBody1 and ImportedBody2 and enter the Multi-Property dialog 

of them. 

6. Set the Layer from 1 to 2 in the General tab. 

7. Click OK. 
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Tip: How to display the Property dialog box for an entity 

 

You can modify parameters of entities at the Property dialog of selected ones.  

  

▪ Here are 3 methods below to open the Property dialog. 

▪ Click Property at the Pop-up menu after clicking right mouse button on a desired 

entity. 

▪ Click Property at the Pop-up menu after clicking right mouse button on selected 

entity in the Working window. 

▪ Press ‘P’ Key which is a shortcut for the Property on keyboard after selecting a 

desired entity in either Database or Working Window. 

▪ How to open Multi-Property dialog 

▪ Open dialog by above 3 methods after selecting several entities either on Data 

Base or in the Working Window.  

▪ There indicate how many entities are selected at the title of Multi-Property dialog as 

shown below figure. 

 

 

Tip: Apply Layer Setting to the modeling 

 

Layer is a tool for controlling Graphic Rendering of the entity on the Working Window. You 

can arrange the entities and simplify the complicating ones by using Layer. Well-arranged 

Layer can be On/Off in Layer Settings dialog.  

 

▪ Know how to use Layer Setting dialog.  

a. Set the Layer number at the General Tab in the 

Property dialog.  

(The Layer number is automatically made in the 

Working Layer when the entity is created)  

b. Layer Settings dialog will be on the display after 

clicking Layer Settings at Render Toolbar. 

 

c. You can hide or display desired entities on the Working Window by checking Layer 

On tab as On/Off individually.  
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▪ Know what the functions there are in Layer Settings dialog.  

▪ Layer Type: There are two type: Select Entity, Highlight Entity 

▪ Select Entity: If this type is checked, the entities in a current subsystem are 

selected except subsystems when layers are selected in grid. This is very 

useful to open property pages for the entities whose layer number is same. 

▪ Highlight Entity: If this type is checked, the entities are highlighted on 

Working Window only when layers are selected in grid. 

▪ Show User-Defined Layer: 255 layers are used in a model. If this option is 

checked, the only layer used by entities on the grids is shown. 

▪ Refresh: Layers can be changed during opening Layer Setting dialog box. 

But layer information in the dialog box is not updated automatically. This 

function updates layer information in the dialog box. 

▪ Layer: The working layer is highlighted by blue in the dialog box. If the highlighted 

layer is turned off, the created entity cannot be displayed in the working window. 

▪ On: The user can set the visibility of the layer in the On checkbox. And the user 

can select or deselect all checkbox by clicking the top of On column. 

▪ Name: The user can set layer names by brief descriptions. If user sets the Name, 

that layer name will be displayed in the property page of entity. 

▪ Note: Cannot change the layer name in the property page of entity. 

▪ Shortcut: The user can toggle the visible status of a layer using the shortcuts.  

▪ Shortcut of Layer1~Layer9: Ctrl + 1~9 keys  

▪ Shortcut of Select All Layer: Ctrl + 0 key 
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To import the remaining geometry: 

1. Follow the instructions above, but this time, 

select the file, Prop_Hub.X_T, from the 

same EngineWithPropeller folder of the 

RecurDyn installation.  

Notice the hub geometry appears in the 

Working window and the body names 

ImportedBody3 and ImportedBody4 appear 

in the Database window.  

2. Change the Layer number of 

ImportedBody3 and ImportedBody4 into 

3. 

3. Follow the instructions above, but this time, 

select the file, Engine.X_T, from the 

EngineWithPropeller folder of the 

RecurDyn installation.  

Notice the engine geometry appears in the 

Working window and eight new body names 

appear in the Database window.  

4. Change the Layer number of newly imported eight bodies (ImportedBody5 ~ 

ImportedBody11 and NONE_4) into 4 

The Working window should display the imported geometry as shown in the figure on 

the right. 

 

To Modify Layer Settings dialog  

1. Click Layer Settings at Render Toolbar. 

Layer Settings dialog will be indicated. 

2. Check Show User-Defined Layer in order to 

see defined model’s layer only. 

3. Change the name of layers like following. 

▪ Name of Layer1: Working Layer 

▪ Name of Layer2: Body Prop_Blade 

▪ Name of Layer3: Body Prop_Hub 

▪ Name of Layer4: Body Engine 

4. Confirm whether Layer is matched well with each 

body by checking and unchecking the On 

checkbox. 

5. Click Close.  
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Adjusting the Icon and Marker Size 

You are now going to change the icon and marker size to 20 pixels, so the icons do not 

obstruct the view of the model. 

To change the icon and marker size: 

1. Display the Icon Control dialog box by clicking the Icon 

Control tool in the toolbar. 

The Icon Control dialog box appears. 

2. Set Icon Size and Marker Size to 20.  

3. Clear the selection of All Markers. 

4. Close the Icon Control dialog box. (use the x in the upper 

right corner) 

 

The graphics display changes from the one shown on the 

previous page to the one shown below.  

 

 

 

Tip: How to turn on/off the marker display 

In addition to changing the size of marker and other entity icons, you can turn off the display 

of the icons. 

Saving the Model 

To save your model: 

Take a moment to save your model before you continue with the next chapter.  

1. From the File menu, click Save. 

2. Enter a name and location for the file. 

3. Click Save. 
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Organizing the Geometry  

Task Objective 

When you often import CAD geometry, RecurDyn translates it into a number of bodies that 

correspond to separated solids in the CAD model. However, these separate solids actually 

move together and should be merged together as a single body in RecurDyn.  

For example, in Chapter 1, the import of the propeller blade resulted in the creation of two 

bodies and the import of the propeller hub resulted in the creation of two additional bodies. 

The two bodies from the propeller blade correspond to the blade supports and blade 

surface. The two bodies from the propeller hub correspond to the hub itself and a shaft.   

For this model, you want the two imported bodies of the propeller blade to move together 

as a single RecurDyn body, and the respective imported bodies of the propeller hub and the 

engine to move as one. In this chapter, you will merge the imported bodies together to 

develop a RecurDyn model that you can work with efficiently. 

Estimated Time to Complete 

20 minutes 

  

Chapter 

3 
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Merging the Imported Geometry 

The table below shows the relationship between the bodies that you are going to work with 

in the RecurDyn model and the imported bodies. You will merge imported geometry to 

form the engine body, the propeller hub body and the propeller blade body. Each merged 

body has the combined mass properties of all of the solid geometry of the corresponding 

imported geometry.  

Body Name Imported Geometry 

Prop_Blade ImportedBody1, ImportedBody2 

Prop_Hub ImportedBody3, ImportedBody4 

Engine ImportedBody5, NONE_4, 

ImportedBody6, 

ImportedBody7, 

ImportedBody8, 

ImportedBody9, 

ImportedBody10, 

ImportedBody11 

 

To merge the propeller blade geometry:  

The merge process consists of two steps. First you will select the bodies that are to be 

merged (Source Bodies). Second you will select the Target Body which will become the 

merged body that will contain all of the geometries of the Source Bodies as well as the 

geometry it previously had. It is allowable for the Target Body to be one of the Source 

Bodies and is typically convenient for that to be the case. Often the easiest method for 

selecting the Source Bodies is to draw a box that included the Source Bodies in the model 

window or Layer Setting dialog 

1. Select the YZ working plane from the Toolbar. 

2. Open Layer Settings dialog by clicking Layer Settings at Render Toolbar. 

3. Check On of only the Layer2 in order to see body which will be defined as Propeller 

blade.  

4. Draw a box in the Working window that covers the left half of the propeller blade bodies 

or click Layer2 in Layer Settings as shown below.  

Engine 

Body 

Propeller 

Hub Body 

Propeller 

Blade Body 
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5. The names of the bodies ImportedBody1 and ImportedBody2 will be selected in the 

Database window. 

6. From the Tools group in the Home tab., click Merge.  

 

The Merge Body dialog box appears. ImportedBody1 

and ImportedBody2 are selected.  

 

 

 

 

 

7. Click the B button in order to choose the Target Body.  

8. To select the Target body, do one of the following: 

▪ In the Working window, click on the propeller. As 

you see ImportedBody2 will be selected, but it 

doesn’t matter if ImportedBody1 is selected 

instead.  

OR 

▪ From the Database window, drag the name 

ImportedBody2 into the Navigation Target window 

which appears in the upper-right corner of the modeling 

window. 

9. Click OK.  

 

To merge the propeller hub geometry: 

1. Activate On check of Layer3 only to see body which will be defined as a Propeller hub. 

2. Select the hub and the shaft geometry as shown in the figure. The names of the bodies 

ImportedBody3 and ImportedBody4 will be selected in the Database window. 
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3. As before, select the Merge tool. The Merge Body 

dialog box appears. ImportedBody3 and 

ImportedBody4 are selected 

4. Click the B button.  

5. For the Target Body, select the propeller hub 

geometry (ImportBody3). 

6. Click OK.  

 

 

 

 

 

To merge the engine geometry: 

1. Activate On check of Layer4 only to see body which will be defined as Engine. 

2. Draw the selection box around the engine geometry as shown in the figure. The names 

of the bodies ImportedBody5 through ImportedBody11 will be selected in the 

Database window. 

3. As before, select the Merge tool. The Merge Body 

dialog box appears. 

ImportedBody5~ImportedBody11 and NONE_4 

are selected. 

4. Click the B button.  

5. For the Target Body, select the lowest geometry on the 

engine (ImportedBody11). 

6. Click OK.   

 

7. Active all of On checks in Layer Settings dialog to see 

entire entities. 

8. Close Layer Setting dialog.  
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Notice that the number of markers is reduced because when the bodies were separate, 

they had one marker individually defining the center of their mass. Now that they are 

merged, there is only one body and one marker at the combined center of mass for each of 

the three remaining bodies, as shown in the figure below. 

 

 

Renaming the Bodies 

Now you will change the names of the three bodies so that you can 

more easily identify them.  

To change their names:  

1. In the Database window, right-click ImportedBody2.  

2. From the menu that appears, select Rename. 

3. Type in the name Prop_Blade1. 

 

 

 

 

4. Following the procedure in Steps 1 – 3, change the name of 

body ImportedBody3 to Prop_Hub, and change the name of 

body ImportedBody11 to Engine. 

The list of bodies in the database window appears as shown at 

right: 

  

Before Merge After Merge 
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Creating a Second Propeller Blade 

Now you will create a second propeller blade by copying the first blade.  

To create a second propeller: 

1. To copy the propeller in place, check and make sure the Shift when pasting option is 

turned off: 

a. From the Settings group in the Home tab, click General. The General Setting 

dialog box will appear. 

b. Make sure the Shift when pasting check box is not checked. 

c. Click OK 

2. Rotate the image to get a front view of the propeller as follows: 

Select Change to XY. 

 

 

3. In the Working window, select Prop_Blade1. Tip: You can also place the cursor over 

the Prop_Blade1 name in the Database window and click. 

Now you can copy and paste the blade to create the second propeller blade. RecurDyn 

is a Windows application that supports several methods for copying and pasting.  

4. To copy the blade: 

▪ Type Ctrl-C on the keyboard. 

OR 

▪ From the Clipboard group in the Home tab, in, click Copy.  

OR 

▪ In the Working window, right-click and from the menu that 

appears, click Copy.   

5. To paste the propeller, use the same techniques you used for 

copy (Ctrl+V, click  Paste or use the same menus as explained 

above).  

You will not see the new blade because it shares the space of the 

original blade. However, there will be a new body entry in the 

Database window, C1_Prop_Blade1. Notice that in the Database 

window RecurDyn prepends C1_ to the name of the original body 

to form the name of the new body. 
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Rotating the New Blade 

You need to rotate the new blade, so it is on the opposite side of the engine axle from the 

original blade. 

 To rotate the blade:  

1. On the toolbar, click the Basic Object Control tool to display the Basic Object Control 

dialog box. The Translate tab is active. 

2. Be sure the C1_Prop_Blade1 body (the 

new propeller) is selected.  

3. Click the Rotate tab in the Basic Object 

Control dialog box. 

4. Change the value of the Degree field to 

180. 

5. Click one of the Z Rotation tools to rotate 

the blade 180 degrees (either direction 

yields the same result.) 

Your model should appear as shown in the figure. 

Tip: How to rotate about different coordinate systems 

The default in the Object Control Panel is to rotate an object about the global coordinate system 

(the default for the Reference Frame text box). If you need to rotate an object about an axis 

in a different reference frame, then click the M button and select the marker of interest. 

 

6. Close the Basic Object Control dialog box (use the x in the upper right corner). 

7. Change the information of C1_Prop_Blade1 like following configuration by opening 

the General tab in Property dialog.  

▪ Name: Prop_Blade2 

▪ Layer: 2 
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Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

the file menu, click Save, or click the Save icon in the quick access toolbar at the top of 

the RecurDyn window.) 
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Creating Joints  

Task Objective 

In this chapter, you will create several joints. You will create: 

▪ One revolute joint to attach each propeller blade to the propeller  

▪ One cylindrical joint to attach the propeller hub to the engine  

▪ One fixed joint to fix the engine to ground 

You will also define the rotation of the propeller.   

Estimated Time to Complete 

15 minutes 

  

Chapter 

4 
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Attaching the Blades to the Hub with Revolute Joints 

In this section, you will use revolute joints to attach the propeller blades to the propeller 

hub. You will first set the working plane and adjust the grid size. A grid size of 10 in each 

direction will make it convenient to use the grid and to locate some of the joints that you 

will define. 

To set the working plane: 

Set the working plane to the YZ Plane. 

To change the grid size:  

From the Working Plane group in the Home tab, set the following: 

1. XGridSize: Input 10 and press the Enter key 

2. YGridSize: Input 10 and press the Enter key 

 

To attach Prop_Blade1 to the propeller hub: 

1. From the Joint group in the Professional tab, click Revolute. 

2. Set the Creation Method toolbar to: Body, Body, Point 

 

3. Click the Prop_Hub geometry. 

4. Click the Prop_Blade1 geometry (on the left). 

5. In the Input Window toolbar, enter the point -5, -31, 6. (type the values, hit Enter key) 

 

To attach Prop_Blade2 to the propeller hub: 

1. Click Revolute again. 

2. Keep the Creation Method toolbar as: Body, Body, Point 

3. Click the Prop_Hub geometry 

4. Click the Prop_Blade2 geometry (on the right). 

5. In the Input Window toolbar, enter the point -5, 31, 6.  

You should see the joint icons as shown in the figure below. 



E N G I N E  W I T H  P O R P E L L E R  T U T O R I A L  ( P R O F E S S I O N A L )  

 

24 

Attaching the Propeller Hub to the Engine 

To attach the Prop_Hub body to the engine body with a cylindrical joint: 

1. From the Joint group in the Professional tab, click Cylindrical. 

2. Set the Creation Method toolbar to: Body, Body, Point, Direction 

3. Click the Engine geometry. 

4. Click the Prop_Hub geometry. 

5. Click the point 0, 0, -40 in the Working window or enter 0, 0, -40 in the Input Window 

toolbar.  

6. To set the direction, click the Z-axis of the inertia reference frame (the yellow arrow 

pointing up in the middle of the propeller hub). 

  

Z-axis of the inertia 

reference frame 
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Attaching the Engine to Ground with a Fixed Joint 

To attach the engine body to ground with a fixed joint: 

1. From the Joint group in the Professional tab, click Fixed. 

2. Set the Creation Method toolbar to: Body, Body, Point 

3. To select ground, click anywhere in the Working window where there is no geometry. 

4. Click the Engine geometry. 

5. Click the point 0, 0, -120 in the Working window or enter 0, 0, -120 in the Input 

Window toolbar.  

You should see the joint icons as shown in the figure below. 

 

Defining the Rotation of the Propeller 

You will now define a constant acceleration of the propeller that begins 0.1 seconds after 

the simulation starts. 

To define the rotation of the propeller: 

1. Display the Properties dialog box of the Cylindrical Joint. 
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2. Check Include Rotational Motion.  

 

 

 

 

 

 

 

 

 

 

3. Click Rotational Motion.  

The Motion dialog box appears.   

 

 

4. Set the menu labeled Displacement (time) to 

Acceleration (time). 

5. Click EL. 

The Expression List dialog box appears.  

 

 

 

 

6. Click Create.  

The Expression dialog box appears.  
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7. To define a rotational acceleration 

of 10π radians/sec2 after 0.1 

seconds of simulation time, enter 

the following expression in the 

large text box:  

IF(TIME-0.1: 0, 0, 10*PI) 

 

 

 

 

 

 

 

 

8. Click OK to exit the Expression dialog box. 

9. Click OK to exit the Expression List dialog box. 

10. Click OK to exit the Motion dialog box 

11. Click OK to exit the Cylindrical Joint Property dialog box. 

 

Saving the Model 

Take a moment to save your model before you continue with the next chapter. (Tip: From 

the File menu, click Save) 
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Creating Forces 

Task Objective  

In this chapter, you will learn to create forces controlling the translation of the propeller and 

the local rotation of the propeller blades. 

Estimated Time to Complete 

10 minutes 

  

Chapter 

5 
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Controlling the Translation of the Propeller 

To create a translational spring force between the Prop_Hub and the engine: 

1. From the Force group in the Professional tab, click Spring. 

2. Set the Creation Method toolbar to: Body, Body, Point, Point 

3. Click the Engine geometry. 

4. Click the Prop_Hub geometry. 

5. Click the point 0, 0, -80 in the Working window or enter the point 0, 0, -80 in the Input 

Window toolbar. 

6. Click the point 0, 0, -40 in the Working window or enter the point 0, 0, -40 in the Input 

Window toolbar. 

 

Controlling the Local Rotation of the Propeller Blades 

To control the rotation of the propeller blades, you will create two rotational springs.  

To create a torsion (rotational) spring between Prop_Hub and Prop_Blade1: 

1. From the Force group in the Professional tab, click Rotational Spring. 

2. In the Creation Method toolbar, select Joint. 

3. Click the Revolute Joint (RevJoint1) at Prop_Blade1 (on the left). 

 

To create a torsion (rotational) spring between Prop_Hub and Prop_Blade2: 

1. Select the Rotational Spring tool again. 

2. Click the Revolute Joint (RevJoint2) at Prop_Blade2 (on the right). 

 

 

You should see the new force icons as shown in the next figure, as well as new joint and 

force entries in the Database window. 

Revolute joint 

to select 

Revolute joint 

to select 
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Saving the Model 

Take a moment to save your model before 

you continue with the next chapter. (Tip: 

From the File menu, click Save.)  
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Performing Analysis 

Task Objective 

In this chapter, you will run a simulation of the model you just created. You will rerun the 

simulation several more time later in the tutorial as you experiment with some changes to 

some of the model parameters.  

Estimated Time to Complete 

5 minutes 

  

Chapter 

6 
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Performing Dynamic/Kinematic Analysis 

You will run a dynamic/kinematic analysis to view the effect of forces and motion on the 

model you just created. 

To perform a dynamic/kinematic analysis:  

1. From the Simulation Type group in the Analysis tab, click Dyn/Kin. 

The Dynamic/Kinematic Analysis dialog box appears.  

2. Define the end time of the simulation and the 

number of steps:  

▪ End Time: 2 

▪ Step: 200 

▪ Plot Multiplier Step Factor: 5 

 

 

3. Click Simulate.  

RecurDyn calculates the motions and forces 

acting on the engine with propeller model. There 

will be 1000 plot outputs stored because the 

number of steps is 200 and the Plot Multiplier 

Step Factor is 5.  

 

 

4. Animate the model using the Play on the Animation Control group in the Analysis 

tab. Refer to the 3D Crank Slider tutorial for more information on playing an animation. 

5. Click Stop to reset the model. 
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Creating Scopes and Setting 

Force Display 

Task Objective 

Before you run another simulation, you will create output data scopes that let you view 

analysis results in small plotting windows as you animate the model. The scopes let you 

monitor angles, points, entities, and components of entities and with this model you will 

use them to monitor the local rotational motion of the blades. In addition, you will use the 

force display to monitor the forces at the revolute joints that attach the blades to the hub. 

Estimated Time to Complete 

10 minutes 

  

Chapter 

7 
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Creating Scopes of Revolute Joint Rotation 

You will create two scopes that measure the: 

▪ Rotation at RevJoint1, which connects Prop_Blade1 to the Prop_Hub 

▪ Rotation at RevJoint2, which connects Prop_Blade2 to the Prop_Hub 

To create a scope on a joint:  

1. From the Scope group in the Analysis tab, 

click Entity. 

The Scope Entity dialog box appears. 

2. Click Et and then click the RevJoint1 icon in 

the Working window, the icon for the revolute 

joint on the left side of the hub that connects 

Prop_Blade1 to the Prop_Hub body.  

The name of the selected joint appears in the 

Entity Name text box. 

The selection in the Component text box is 

Pos1_Relative. This is the rotational angle of 

the revolute joint and it is the output that you 

want. You do not need to change it. 

3. Change the name of the scope to 

Scope_Rev_Ang1. 

4. Click OK.  

The scope plot appears with the angle rotation from the previous simulation. Note that 

the total rotation is small —only 0.3 degrees.  
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5. Now repeat Steps 1 - 5 with the changes needed to display the rotation of RevJoint2., 

naming the scope Scope_Rev_Ang2.  

 

The second scope plot shows that the second revolute joint rotated the same amount as 

the first, but it has the opposite sign. The first blade rotates a small amount 

counterclockwise (about the Z-axis of the joint’s base marker) due to gravity, which is a 

positive rotation. The second blade rotates a small amount clockwise due to gravity, 

which is a negative rotation.  

 

Tip: How to select an entity from the Database window 

The Navigation Target window appears when you click the Et button 

while trying to create a scope. Rather than clicking on the entity icon 

in the Working window you could also drag the name of the entity 

in the database window to the Navigation Target window in order to 

select that entity.  
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Setting Display of Forces 

In this section, you will set up the display of the force in the translational spring along the 

propeller shaft during an animation.  

To set up the force display of the translational spring, Spring1:  

1. Display the Properties dialog box for 

Spring1.  

The bottom item is the Force Display. Its 

default value is Inactive.   

2. Set Force Display to Action. 

3. Click OK. 

You will not see any difference if your 

graphics are in the shaded mode. You 

need to change them to the wireframe 

rendering to see the force vector.   

4. Switch to the wireframe mode: 

a. Right-click the Working window.   

b. From the menu that appears, point 

to Rendering Mode, and then click 

Wireframe with Silhouettes.   

5. Now use the Play on the Animation Control group in the Analysis tab to run the 

animation and look just above the coil spring on the propeller shaft for the force display. 

It will be a blue arrow pointing up. It spikes up a small amount and then quickly settles 

to a constant value (the weight of the propeller hub and blades). 

6. Click Stop to reset the model. 

Tip: Force Display  

In the Display Setting or Force Display function, you can control for the force display on 

the animation state on the Working Window. (Display Setting option is in Setting group 

of Home tab, Force Display option is in Post Tool group of Analysis tab.) 

This command defines a force/torque display during the playing of an animation. The force 

display is as shown below. 
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Saving the Model 

Take a moment to save your model before you continue with the next chapter. 
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Performing a Design Study 

Task Objective 

Your model with the default spring parameters behaves in a very stiff manner. The motion 

of the propellers seems to suggest a rigid connection rather than a flexible connection. In 

this chapter, you will learn how to use RecurDyn to study the effect of stiffness and 

damping on the dynamic response of a mechanical system. 

Estimated Time to Complete 

15 minutes 

  

Chapter 

8 
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Adjusting the Stiffness and Damping of Rotational Springs 

You will use the two springs to study two factors:  

▪ With RotationalSpring1, you will reduce both the stiffness and damping by a factor of 100.  

▪ With RotationalSpring2, you will reduce the damping by an additional factor of 10. 

To adjust the stiffness and damping of the rotational springs: 

1. Display the Properties dialog box for 

RotationalSpring1.  

2. Set the Stiffness to 100 and the 

Damping to 1 as shown above. 

3. Click OK.  

 

 

 

 

 

 

 

4. Display the Properties dialog box for RotationalSpring2.  

5. Set the Stiffness to 100 and Damping to 0.1 (the same stiffness but lower damping). 

6. Click OK. 
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Running a New Analysis 

You are ready to run a simulation with the modified spring parameters. As you run the 

simulation, you will adjust a few simulation parameters to get the best answer for this 

model. 

To run a new analysis with the modified spring parameters: 

1. From the Simulation Type group in the Analysis tab, click Dyn/Kin. 

The Dynamic/Kinematic Analysis dialog box appears. Notice that the end time of the 

simulation and the number of steps have the values that you set in the first simulation. 

Therefore, you need to make no changes in the first tab.  

2. Click the Parameter tab and set:  

▪ Maximum Time Step: 0.001 

▪ Numerical Damping: 0.1 

The default values for Maximum Time Step 

and Numerical Damping work well for many 

practical problems that have many parts and 

high stiffness. For this model, you change 

them because: 

 

▪ Numerical Damping is applied at the 

system level and helps a model 

simulate smoothly when there is no 

damping defined for degrees of freedom 

at the joints. In this model, you have 

damping defined for each degree of 

freedom and you are studying the effect 

of reducing the spring damping. In this 

case, it is a good practice to reduce the 

Numerical Damping from 1.0 to 0.1.   

▪ The Maximum Step Size is reduced 

because the numerical integrator in 

RecurDyn will take large steps with such 

a simple model that exhibits smooth motion. A smaller maximum time step is 

appropriate because you want to capture the gradual decay of the blade motion.  

3. Click Simulate.  

The simulation will run in a few seconds. 
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You will see some significant changes in the data shown on the two scopes. Both blades 

are moving through approximately 20 degrees of initial rotation. There is much more 

oscillation in blade motion. Now is a good time to animate the model to observe the 

behavior that is suggested by the plots.  

 

4. Use the Animation play button on the Animation Control group in the Analysis tab to 

display the animation as explained in the beginning tutorial. 

5. Click Stop button to reset the model. 
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Questions to Consider from the Design Study Results: 

Here are a few questions. The answers are provided later.  

1. Why did the blades move through a larger displacement in the second simulation? 

2. Why did the blades oscillate more in the second simulation? 

3. Why did Prop_Blade2 oscillate more than Prop_Blade1? 

4. Why does the magnitude of the average rotation of the blades decrease in the later 

portions of the simulation? 

5. How could you check for the accuracy of the solution? 

Answers to the questions: 

 

 

Ideas for Further Exploration: 

You obtained interesting changes to the model results by changing the stiffness and 

damping values of the rotational spring.   

1. How could you change the values of stiffness and damping in the coil (translational) 

spring? 

2. Think about the experimentation process. You may have a hard time to recognize which 

change in which variable caused the changes of the output if you change the stiffness 

and the damping at the same time. 

3. What change in response would you expect if you changed the gravity to act in the –Y 

direction? Make the change and see if you were correct. 

You can change the direction of the gravity vector by using the Gravity command in the 

Settings menu. 

  

1) Reduced stiffness in the rotational springs.   

2) Reduced damping in the rotational springs.   

3) Reduced damping in rotational spring #2.     

4) As propeller spins at a higher rotational velocity the centripetal acceleration increases 

and tends to offset the effects of gravity.          

5) Set the Maximum Time Step to 0.0001 (10x lower) and run the simulation again.  

Since the results are the same you can have confidence in the accuracy of the results. 
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Plotting the Results  

Task Objective  

In this chapter, you will plot the analysis data that RecurDyn calculated in the 

dynamic/kinematic simulation you ran in the previous chapter. You will plot and work with 

the rotational output of the revolute joints, using the RecurDyn plotting tool. It lets you plot 

and animate the results of simulations.  

Estimated Time to Complete 

10 minutes 

  

Chapter 

9 
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Creating a Plot 

In this section, you’ll start RecurDyn/Plot.  

To start RecurDyn/Plot:  

1. From the Plot group in the Analysis tab, click Plot Result. 

The Plotting window appears with all the tools and data that you need. 

 

2. In the Database window, click the + in front of Joints and RevJoint1, and then double-

click Pos1_Relative to display the rotation of Prob_Blade1 (same as the first scope). 

3. Click RevJoint2, and then double-click Pos1_Relative to 

display the rotation of Prob_Blade2 (same as the second 

scope).  
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The plot appears as shown next. It contains both curves of the two scopes in the same 

plot. It would be beneficial to be able to compare the two blade rotations, but the 

comparison is difficult because one curve has negative values and the other curve has 

positive values. You will use the analysis capability in the plotting tool to make this 

comparison easier. 

 

 

4. Before using the Simple Math tool to draw the curves at the same 

axis, check and make sure the At Current Axis option is turned on. 

(Current Axis option is in Multiple Axes group of Home tap) 

 

 

 

 

 

5. From the Analysis group in the Tool tab, click Math. The Data Analysis dialog box 

appears.  

6. Click on the field to the right of the Math Type field, to display the dropdown menu 

button. 

  



E N G I N E  W I T H  P O R P E L L E R  T U T O R I A L  ( P R O F E S S I O N A L )  

 

46 

7. Select the Math Type to 

Scale:alpha*F1  

8. Set the Source Curve1 

(F1) to the second curve, 

Pos1_Relative – 

RevJoint2 (deg). 

9. Set Y Scale Factor to -1. 

10. Click Execute.  

11. Click Close. 

 

 

 

 

 

A new curve (FACTOR(Pos1_Relative - RevJoint2 (deg))) appears on the plot that 

represents the absolute value of the Blade2 rotation. 

 

12. On the plot, click on the original Blade2 rotation curve (Pos1_Relative - RevJoint2 

(deg), with negative values) and you should see the curve become highlighted.   

13. Press the Delete key on your keyboard to delete the curve. 

OR 

From the Tools group in the Home tab, click Delete Curve.  

14. Click Yes when prompted to confirm the deletion of the curve.  

 

15. Click Fit to adjust the curves. 

 

 

16. From the Preference group in the Home tab, click Legend. The Legend Title dialog 

box appears.  

17. Change the Legend #2 title name to Pos1_Relative - RevJoint2 (deg). 

18. Click OK. The legend title is changed. 

19. In the legend box, right-click and from the menu that appears, click Bottom 
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The plot should now appear as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Congratulations! You have completed this tutorial and simulated a multi-body dynamic system! 


	Engine with Propeller Tutorial (Professional)
	Getting Started
	Objective
	Audience
	Prerequisites
	Procedures
	Estimated Time to Complete

	Creating the Initial Model
	Task Objective
	Estimated Time to Complete
	Starting RecurDyn
	To start RecurDyn and create a new model:

	Importing the CAD Geometry
	To import the propeller blade geometry:
	To import the remaining geometry:
	To Modify Layer Settings dialog

	Adjusting the Icon and Marker Size
	To change the icon and marker size:

	Saving the Model
	To save your model:


	Organizing the Geometry
	Task Objective
	Estimated Time to Complete
	Merging the Imported Geometry
	To merge the propeller blade geometry:
	To merge the propeller hub geometry:
	To merge the engine geometry:

	Renaming the Bodies
	To change their names:

	Creating a Second Propeller Blade
	To create a second propeller:

	Rotating the New Blade
	To rotate the blade:

	Saving the Model

	Creating Joints
	Task Objective
	Estimated Time to Complete
	Attaching the Blades to the Hub with Revolute Joints
	To set the working plane:
	To change the grid size:
	To attach Prop_Blade1 to the propeller hub:
	To attach Prop_Blade2 to the propeller hub:

	Attaching the Propeller Hub to the Engine
	To attach the Prop_Hub body to the engine body with a cylindrical joint:

	Attaching the Engine to Ground with a Fixed Joint
	To attach the engine body to ground with a fixed joint:

	Defining the Rotation of the Propeller
	To define the rotation of the propeller:

	Saving the Model

	Creating Forces
	Task Objective
	Estimated Time to Complete
	Controlling the Translation of the Propeller
	To create a translational spring force between the Prop_Hub and the engine:

	Controlling the Local Rotation of the Propeller Blades
	To create a torsion (rotational) spring between Prop_Hub and Prop_Blade1:
	To create a torsion (rotational) spring between Prop_Hub and Prop_Blade2:

	Saving the Model

	Performing Analysis
	Task Objective
	Estimated Time to Complete
	Performing Dynamic/Kinematic Analysis
	To perform a dynamic/kinematic analysis:


	Creating Scopes and Setting Force Display
	Task Objective
	Estimated Time to Complete
	Creating Scopes of Revolute Joint Rotation
	To create a scope on a joint:

	Setting Display of Forces
	To set up the force display of the translational spring, Spring1:

	Saving the Model

	Performing a Design Study
	Task Objective
	Estimated Time to Complete
	Adjusting the Stiffness and Damping of Rotational Springs
	To adjust the stiffness and damping of the rotational springs:

	Running a New Analysis
	To run a new analysis with the modified spring parameters:

	Questions to Consider from the Design Study Results:
	Ideas for Further Exploration:

	Plotting the Results
	Task Objective
	Estimated Time to Complete
	Creating a Plot
	To start RecurDyn/Plot:




